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19 Man’s Best Friend Document

Create a one (1) page Man’s Best Friend document.
Using the sample as a quide, format your document
following the directions below.

Your document will not look exactly like the sample
as you will choose your own picture and some
text formatting options.

] On the task bar, click the word icon @ to open the Word 2013 Application.
1 Open a blank word document.

] Save the file in your Documents Folder:
File > Save As > My Documents

1 Name your file: Word 19 YourFirstNameLastInitial
Click Save.

In the page Layout tab:
Size: 8.5x 11
Orientation: Portrait
Margins: Wide

Open the Word 19 Story Text located in the Word 19 folder

O g goad

Using either the digitial copy on screen or print your own copy, and type the
story into your document following the instructions in red on the story text
sheet.

When you have all of the text typed into your document, format your text:

] Text alighment
Check that your text is all Aligned Left (aligned on the left, ragged on the right).

] If itis not, select all the text by holding down the Ctrl key and then press the A
key on the keyboard.

L] Inthe Home Tab, click the Align Left icon.

E}

[ ] Select all your text and change the
Line Spacing of all the text to Single (1.0)

h—
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] Choose 1 font for all the text.
Pick a legible font like:

Calibri
Candara
Corbel
Cambria
Caladea
Century
Garamond

Avoid script, bold or decorative fonts:

Bruch Senipt

AR Berkley

AR BONNIE
AR CARTER
Comic Sans
Elephant
Chiller

You may choose to use Bold for some text
e.g. Bold Heading

[l Format the Title Man’s Best Friend

Font Size: choose between 28 and 36
Font Color: your choice

Paragraph Spacing - Space After: 6pt
Paragraph Spacing - Space Before: 0

[l Format the 3 Paragraphs of Story Text

Font Size: choose between 10.5 and 12 pt
Font Color: your choice

Paragraph Spacing - Space After: 6pt
Paragraph Spacing - Space Before: 0

[] Format the Reference Numbers [1] [2] [3] in the story text.
Select the number [1], hold down the Ctrl key and select [2] and [3].

Click the Home Tab. Click on the Superscript icon to change the numbers to
small text that sits slightly above the line of text.

Calibri (Body) ~|115 | A" A | Aa-

A | ¥
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Below are the instructions to insert a list of references which you will
copy from another document and paste into your story document.
References are the resources the author used to support the statements
made in the story. The numbers in brackets, [1], [2], [3] at the end of the
paragraphs refer to the reference text you will paste at the bottom of the
story you typed:
To access the reference text, open the following document:
WORD 19 EXERCISE > Word 19 Reference Text
Select the text and Copy it.
Close the Word 19 Reference Text document without saving it.
Go to your document and click at the end of the story you typed, and paste.
Format the Reference Text and Title:
Font: Same as your chosen font
Font Size: 8
Font Color: Black
Line Spacing: Single
Paragraph Spacing - Space After: Opt
Paragraph Spacing - Space Before: Opt
Select the title References and add some paragraph space before the story
paragraphs: Paragraph Spacing - Space Before: 18 pt
Select the Reference Text without the title, and change it to a Numbered List.
Style of Numbered List: Number followed by a period as shown in sample.
HOME INSERT DESIGM PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW DEVELOPER
il E;E:t Corbel fn A A Aa- e i=-fEsEe &5 N T || papbeepe aasboede AaBbCe Assbeel AQB| assbeer acst
Pz ...For:atpainw B I U-acx,x A-¥-A- ey ezt B e FrmelE THoSpac.. Headingl Heading2  Title Subtitle  Subtlg
Clipboard B Fant B 1 Styles
L pemeen V1|2 S T R A - SRR R AR
. "Man's best friend 3 sferring to their millennia-long history of
close relations, loy rst recorded instance of the phrase

- MNumbering Library

“man's best friend 1789 was quoted as saying “dog is man's

best friend,” appai iound. It was likely popularized by its use

- 1. 1.

i in a poem by Ogde N 2 2 oquialism.

. one - -

- Before the 1gth ce 3 3. zre largely functional. They performed
N activities such as h = describing the deg often reflected

- these roles. Accore oldest proverbs and phrases dogs are

i rarely depicted as n : ravening, or watchful.” Beginning in
- the 18th century, r 2 1

oth century, language and attitudes
towards dogs beg: 3 3 ittributed to discovery of the rabies

vaccine in 186g.1

In 1870 Warrensbu | A a) a. «d a farmer suing for damages after his
. dog, Old Drum, ha | B. b) b. ncluded this quote, "The one absolutely
- unselfish friend thi | C c) c = that never deserts him and the ons
. that never proves | a statue of Old Drum was erected on
- the Johnson Count of Vest's closing speech, A man's best
-

friend is his dog."" |’
1.
iii.

] References
i 1. Derr, Mark Document Number Formats - NPR. Retrieved 10 October 2013,
- 2 Paton, Ber Cwww.oed.com. Oxford English
b Dictionary | q
3. Coren,5t3 | 5 senator, the Dog, and the Trial".
7 Psycholog | 4
4 Dewitt, Dz In a More Innocent Era”. The Trial of
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Insert an image of a dog into the document. Choose any image you like.
Place the image anywhere on the top half of the page.

Size: The image must be a minimum of 1.5 x 1.5 inches

O 0O 0o 0

Your image will be “Locked” (In line with Text) when you insert it into your
document. To unlock the picture:

Click the Layout Options icon to the right of the image and choose
one of the With Text Wrapping options (square) and Fix Position on
Page to allow the picture to be moved within the document.

= e

[ Sizing your Picture
Resize using the corner handles only.
The middle handles will distort (squish or stretch the picture).

Crop Tool
change the

picture, use
crop tool.

[ Add a border to your picture. In the Picture Tools Format Tab, choose picture
border and select the colour, weight and line line style.

[J If your title text is 2 or 3 lines, change the line spacing between the words to bring
them closer together by using exactly line spacing instead of single line spacing in
the paragraph setting box.

e.g.

’ .
M a n 5 Text size 36 pt M a n’ s Text size 36 pt

Best>x ~<_Best

Eriend Friend

Line spacing: Al Line spacing: At

1 F

single w Exactly | |34 pt
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Adding Hyperlinks:

A hyperlink is an element in an electronic document that links to another
place in the same document or to an entirely different document or website.

In the reference section, you will add 1 hyperlink to each of the 3 references.
The hyperlinks you create will link to the stories located on various websites
on the Internet.

] If you need to get a closer look at the text, zoom into the text by holding
down the Ctrl key and roll the wheel on your mouse. Rolling forward zooms in,
rolling backward zooms out.

[ Reading Reference 1:
Story Author: Bernadette Paton
Story Title: The dog: man’s best friend?
Website: www.oed.com (Oxford English Dictionary)

1.  Paton, Bernadette (2013). "The dog: man's best friend? (The use of man's best friend has
usually been about dogs. They are hard working and reliable mammals)". www.oed.com.
Oxford English Dictionary. Retrieved July 5, 2013,

[] In your internet browser search engine, type:
the website
author’s last name
part of title

oed.com paton man’s best friend

[] In the search results, we can see a link that includes the website and story title
but not the author’s name. Click on the link to go to the web page.

oed.com paton man's best friend Q
All Images News Videos Maps Mare Settings Tools
About 191,000 results (0.67 seconds)

Linlg\
A The dgg: man's best friend? | Oxford English Dictionary
https:,ﬁ& oed_com/blog/word-stories-dog/ -
In the ol proverbs and phrases dogs are rarely depicted as faithful or as man'’s best friend, but as
vicious, ravening, or watchful. To throw or cast someone to the dogs (from 1556) is to send them to
destruction or ruin, as is the later and now more common to go to the dogs (from 1619)
Vicious, ravening, and ... - (miserable) dog's life - Modemn attitudes: laps ...

ESM Digital Technology
Page | 5



MODULE 5 WORD
19 Man's Best Friend Document

2020
[] Scroll down to the bottom of the story on the web page, you will see the
author’s name is a match — Bernadette Paton.
The link is a match as it has all the information listed in the reference text.
C @ ® © & httpsy//publicoed.com/blog/word-stories-dog B (0% e @ | Q Search & m o @@

Q ABOUT - COMMUNTY - BLOG

Home > Blog >

The dog: man’s best friend?

] You will now copy the address of the web page: click your cursor in the address
bar of the web browser to select the address text (selected text is blue).

[ With your cursor in the blue area, right click your mouse and click Copy.

https://public.oed.com/blog/word-stories-dog

P
[ L]
L

1 Go to your word document. In the reference section, select the title of the
story you are making a hyperlink for.

References

1.  Paton, Bernadette (2013). "The dog: man's best friend? (The use of man's best friend has
usually been about dogs. They are hard working and reliable mammals)". www.oed.com.
Oxford English Dictionary. Retrieved July 5, 2013.

2. Coren, Stanley (2009-10-21). ""A Man's Best Friend is his Dog": The Senator, the Dog, and
the Trial". Psychology Today. Retrieved 2010-09-27.

3. The Trial of Old Drum — New York Times Television Review — June 9, 2000

L1 Click the Insert Tab. In the Links Grouping, click the Hyperlink icon.

FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW DEVELOPER

: = | B2 . W B (B [
[ . T | mmar
B [ o ke [ 5 1l @, @ (& & [t L[
Cover Blank Page Table | Pictures Online Shapes Smart4rt Chart Screenshot aM}'Apps - Wikipedia = Online | Hypgelink Bookmark Cross-

Page~ Page Break < Pictures - < Video reference
Pages Tables Illustrations Add-ins Media Links
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] Place your cursor in the Address box on the bottom of the Insert Hyperlink
window. Right click your mouse, click Paste.
Insert Hyperlink 7 X
Link to: Text to display: |'The dog: man's best friend? (The use of man’s best friend has usuall| ScreenTip...
Look in: | Word 19%a Man's Best Friend Doc I:'
Existing File
or Web Page Bookmark...
Current =
Folder Target Frame...
Place in This
Document Browsed
Pages
Create Mew Recent
Document Files
Address: || w
E-mail |_ b4
Address
B o =
"D Paste r
S U
The address box displays the website of the link:
Insert Hyperlink ? x
Link tao: Text to display: |'The dog: man's best friend? [The use of man's best friend has usuall| ScreenTip...
Look in: v| |2
Existing File | _ { . .
or Web Page .

Current
Folder Target Frame...

Place in This

Document Browsed

Pages
Create New Recent
Document Files
L
Address: https:f.-‘public.oed.ccum.."bIogMord-stories-dogd
E-mail
Address

I OK I ‘ Cancel
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At the top of the pop out window, The Text to display Box shows the title of
the link, that is, the text used to describe the link.

In this exercise, we are using the name of the story to describe our link,
therefore we will not type a new title to describe the link.

1 Click OK. Your link will display in your document as coloured underlined

text.
Insert Hyperlink ? X
Link to: Text to display: | "The dog: man's best friend? (The use of man’'s best friend has usuall SereenTip...
Look in: i P ﬁ
Existing File
ar Web Page ~ Bookmark...
Current
Folder Target Frame...
Place in This
Document Browsed
Pages
Create New Recent
Document Files
v
Address: https:_r'_r'pubIic.oed.corn_e'bIog;Word-stories-dog_eI e
E-mail
Address
0K I | Cancel

Does your link look the same as below?

] Check to see if your link works:
Hover your mouse over the link. You should see a pointed finger.
If you don’t see a pointed finder, press and hold down
the Ctrl key and click.

References

1. Paton, Bernadette (2013). "The dog: man's best friend? [The use of man's best friend has
usually been abonyt dogs. They are hard working and reliable mammals)”. www_oed.cam.

Oxford English ary. Retrieved July 5, 2013.
2. Coren, Stanley | 10-21). ""A Man's Best Friend is his Dog": The Senator, the Dog, and

the Trial". Psychology Today. Retrieved 2010-09-27.
3. The Trial of Old Drum — New York Times Televizion Review —June 3, 2000
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] Your web browser will launch and open the web page that is
associated with the link.

[J Once the link is clicked in your document, it will change colour
(purple) to indicate you have used that link.

References
1. Paton, Bernadette (2013). "The dog: man's best|friend? [The use of man's best friend has
usually been about dogs. They are hard working and relizble mammals)". www.oed.com.

Cwfard English Dictionary. Retrieved July 5, 2013.
2. Coren, Stanley (2009-10-21). ""A Man's Best Friend is his Dog": The Ssnatar, the Dog, and
the Trial". Psychology Today. Retrieved 2010-09-27.

= Tha Trial ~F Ald Diroes — Kleas Vel Tisnese Talaviciaem Deadswr — i
[ I T r— ne 9_, 2000

B wm w© z2mod

The dog: man’s best friend?
2 |

[ Following the instructions on pages 5-8, Insert a hyperlink for reference 2

Hyperlink text:

2. Coren, Stanley (2009-10-21). ""A Man's Best Friend is his Dog": The Senator, the Dog, and
the Trial". Psychology Today. Retrieved 2010-09-27.

ESM Digital Technology
Page | 9



Webpage:

MODULE 5 WORD

19 Man's Best Friend Document

2020

Pstchology Today

Find a Therapist - Get Help ~ Magazine Today

Stanley Coren PhD., DSc,
FRSC

Canine Comer

o

“Man’s Best Friend”: The
Senator, the Dog, and the Trial

A high profile trial produces an emotional statement about dogs.

Pasied Oct 3, 2005

dog,” or some variation of that phrase. However | doubt that very many
people know where that adage came from. It can be found in the transcript
of a trial, and it was part of one of the most memorable closing arguments
ever made by a lawyer. The trial was held in Missouri in September of 1870,

w

and it concerned the killing of a dog.

The case revolved around a black and tan hound named Oid Drum, who
was the favorite dog of a farmer named Charles Burden. A nearby neighbor,
Lecnidas Homsby, owned a considerable amount of livestock. Because
Hornsby had lost some sheep, presumably due to attacks by local dogs, he
swore to shoot any dog he found on his property. On October 28, 1869,
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] Following the instructions on pages 5-8, Insert a hyperlink for reference 3

Hyperlink text:

3.

The Trial of Old Drum — New York Times Television Review —June 9, 2000

Webpage:

= SECTIONS

W
=g

@ HOME Q searcH The New ﬂﬂl’k Times

‘Ma’ Review: Octavia

CRITIC'S PICK i

‘Rocketman’ Review: The . ‘Godzilla" Sequel i Spencer Serves Up Liquor,
Fantastical Tale of Elton Disappoints, but Leaves a Terror and a Killer

John, Survivor, Rock God... Bigger Footprint Overseas Performance

ARCHIVES 2000

By DAVID DEWITT  JUNE 9, 2000

Only the most hard-hearted can resist the sight of a boy crying when his
dog faces death. Why else is "Old Yeller," an iconic American movie,
recalled when filmmakers want a hard character to reveal a heart?

Fair warning: I'm a dog owner myself, and the harder parts of my heart
turned to mush during moments in "The Trial of Old Drum," an original
movie having its premiere tonight on Animal Planet. When the golden
retriever Old Drum whimpers after a gunshot wound, when he howls as
he is separated from his young master, when he offers a peacemaking

paw to the town villain -- O.K,, everyone, a collective "aaw."

"The Trial of Old Drum" is manipulative and awkward, and it features
spotty acting, washed-out landscapes, wince-inducing dialogue, leaps of
reason and a load of bathos. Its fans won't care. At its best, "Old Drum"

relates a classic story of a boy and his dog.

It's Going Grear for
Richard Madden. That's
‘What Worries Him

TV WEEKEND; A Boy-and-His-Dog Story In a More Innocent Era

00

TIP: You can edit, open, copy and remove a link by hovering over it
and right clicking your mouse to select an option from the menu.

L1 Proofread your work:

Use the spell check in Word AND read your document and compare it to the
original text you typed from. Check for spelling and punctuation.

[ Save your document and email it to your instructor.

ESM Digital Technology
Page | 11



	Size 85 x 11: Off
	Orientation Portrait: Off
	Margins Wide: Off
	Text alignment: Off
	On the task bar click the word icon: Off
	Open a blank word document: Off
	Save the file in your Documents Folder: Off
	Name your file Word 19 YourFirstNameLastInitial: Off
	Open the Word 19 Story Text located in the Word 19 folder: Off
	Using either the digitial copy on screen or print your own copy and type the: Off
	If it is not select all the text by holding down the Ctrl key and then press the A: Off
	In the Home Tab click the Align Left icon: Off
	Select all your text and change the: Off
	Choose 1 font for all the text: Off
	Format the 3 Paragraphs of Story Text: Off
	Format the Title Mans Best Friend: Off
	Format the Reference Numbers 1 2 3 in the story text: Off
	To access the reference text open the following document: Off
	Select the text and Copy it: Off
	Go to your document and click at the end of the story you typed and paste: Off
	Format the Reference Text and Title: Off
	Select the title References and add some paragraph space before the story: Off
	Select the Reference Text without the title and change it to a Numbered List: Off
	Insert an image of a dog into the document Choose any image you like: Off
	Place the image anywhere on the top half of the page: Off
	Size The image must be a minimum of 15 x 15 inches: Off
	Your image will be Locked In line with Text when you insert it into your: Off
	Sizing your Picture: Off
	Add a border to your picture In the Picture Tools Format Tab choose picture: Off
	If your title text is 2 or 3 lines change the line spacing between the words to bring: Off
	If you need to get a closer look at the text zoom into the text by holding: Off
	Reading  Reference 1: Off
	In your internet browser search engine type: Off
	In the search results we can see a link that includes the website and story title: Off
	Scroll down to the bottom of the story on the web page you will see the: Off
	You will now copy the address of the web page click your cursor in the address: Off
	With your cursor in the blue area right click your mouse and click Copy: Off
	Go to your word document In the reference section select the title of the: Off
	Click the Insert Tab In the Links Grouping click the Hyperlink icon: Off
	Place your cursor in the Address box on the bottom of the Insert Hyperlink: Off
	Click OK Your link will display in your document as coloured underlined: Off
	Check to see if your link works: Off
	Your web browser will launch and open the web page that is: Off
	Once the link is clicked in your document it will change colour: Off
	Following the instructions on pages 58 Insert a hyperlink for reference 2: Off
	Following the instructions on pages 58 Insert a hyperlink for reference 3: Off
	Proofread your work: Off
	Save your document and email it to your instructor: Off


